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1 Introduction
1.1

Preface
Before installing and starting up, this manual must be read carefully.
The manual is an integral part of the product and must be stored for subsequent use.
If you would like further information or if problems occur that are not covered by
the manual, the required information can be obtained from the manufacturer.
Modifications and repairs to the product may only be performed if expressly
permitted by this manual.
Only by observing all of the safety instructions and all safety/warning symbols
in these instructions can optimum protection of both personnel and the environment, as well as safe and fault-free operation of the device, be ensured.

A

Improper use, failure to observe this manual, the use of underqualified
personnel, or unauthorized modifications releases the manufacturer
from liability for any resulting damage. In these cases, the manufacturer's warranty no longer applies.
v Prior to installation and startup, make sure that the operating staff
are familiar with and understand the contents of the operating manual.

1.2

Typographical Conventions

1.2.1 Warning signs
Warning

A

This symbol is used when there may be damage to equipment or
data if the instructions are ignored or not followed correctly!

1.2.2 Note signs
Note

Reference

Action
instruction

H
v
h

This symbol is used when your special attention is drawn to a
remark.
This symbol refers to further information in other manuals, chapters
or sections.
This symbol indicates that an action to be performed is described.
The individual steps are marked by this asterisk, e.g.
h Use OK to confirm
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1 Introduction
1.2.3 Representation
Menu items

File ➔ Save as

Small arrows between the words indicate a
sequence of commands which must be performed
one after another.

1.3 Trademark information
- Microsoft® is a registered trademark of Microsoft Corp., Redmond, VA
98052-6399, US.
- Windows® is a registered trademark of Microsoft Corp., Redmond, VA
98052-6399, US.
- CompactFlash® is a registered trademark of SanDisk LLC, Milpitas, CA
95035-7933, US.
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2 PCA Communication Software
2.1

General information
The PCA Communication Software PCC is used for connecting a PC to a paperless recorder or a controller with recording function in order to transfer
registration data from the device to the PC.
Depending on the device and the PC, different interfaces are available for data
transfer, e. g. serial interface, USB, Ethernet.
Data recorded in the device can be readout manually or automatically (timecontrolled), even from several devices at the same time. All devices and settings are administered in a device list. Several device lists can be created, thus
it is possible to assign devices to different machine lines.
Recording data readout from a device are available in an archive file for evaluation with PC Evalution Software PCA3000.
The PCA Communication Software PCC also offers a teleservice function. With
the teleservice the current process data of a device are displayed in a separate
window. Data of several devices can be displayed at the same time.
Every action performed in the PCA Communication Software PCC is logged by
the PC Audit Trail Manager PCAT.

Scope of delivery

The PCC software is supplied on a data carrier or can be downloaded together
with the following PC programs:
- PC Evaluation Software (PCA3000),
- Setup software (only for certain devices) and
- Documentation in the form of PDF files (data carriers only).

H
2.2

PCA3000 is used for various types of devices. There may be discrepancies between the operating manual and the individual device-specific functions.
The software and all of the respective documents can also be
downloaded online.

Hardware and Software Requirements

Minimum configuration

The following hardware and software requirements must be met to operate and
install the PCC:
- Notebook or desktop PC
- USB port, network connection or free serial interface (depending on the type
of data transfer to the device)
- Windows 7 (SP1) or newer
- compatible Windows Server systems
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2 PCA Communication Software
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3 Installing the software

A

Please consider the folowing items:
- The user who is logged in during installation must be the same as
the one who will subsequently be working with the program.
- The user must have administrator rights during the installation.
The installation will not be carried out correctly unless these
conditions are fulfilled.

Run installation
program

h Start Microsoft Windows

H

If Microsoft Windows has already been started, all Windows
programs must be shut down before installing the software.

h Insert the CD into the drive, then close the drive.
After the CD has been inserted, the installation program will start automatically.
If not, proceed as follows:
h Start file “Launch.exe” in the main directory of the CD.
The installation program will lead you through the rest of the installation with
screen messages.
h Select the software (feature) that needs to be installed.

Software to be installed must be marked by a
tick ( ).
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3 Installing the software
h Now enter the required license numbers.

No 30-day test version is available for installation with an enhanced security
level.
h Define the program folder into which the icons for starting the software will
be copied.

H

The next two steps only need to be performed for an installation
with an enhanced security level.
h Enter the installation options.
h Enter the path for user lists.
Further information is available in the Operating Manual
"PC Security Manager Software."
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3 Installing the software
Starting the
Installation

h Now click

H

to install the selected software components.

With an enhanced security level, you will have the opportunity of
starting the PC Security Manager software directly when the
installation is finished
(
).

h Finish the installation by clicking

H

.

“Devices with an enhanced security level” can only be operated
with the PCC software described here.
“Devices without enhanced security level” can also be operated
with the previous PCA Communications Server software.
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3 Installing the software
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4 Operation
4.1

Starting the Program
h Call up the program from the start menu

The start screen appears, with information about the installed version.

Logging in to
the program

Logging in when starting the program depends on the type of installation.
- If software for a device with an enhanced security level has already been
installed on the relevant PC, there is always a password prompt.
- Normally (without enhanced security level) log-in only occurs when it has
been activated by the user. It can be activated, for instance, through the
function Tools ➔ Renew log-in / Alter password.
v Chapter 8.5.12 "Renew Log-in / Alter Password"
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4 Operation
Password
entry

h Log in to the program. Select your name (user ID) and enter the password.
h Click

.

When you log in for the first time, the password that has been defined may
have to be altered. A request to alter the password will also be made when your
password has expired. When creating the user list, the administrator decides
whether a password can expire (only available with an enhanced security
level).
Password
alteration

h Enter the previous (old) password.
h Then enter the new password and confirm it by entering it again.
h Click

.

You are now logged in under your ID (e.g. Admin).
v B 70.9703.0 PCS Chapter 4 “User List Assistant" (for an enhanced security
level).
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4 Operation
Start automatic
mode after
waiting time

This window appears if the option "Activate automatic mode after starting program" has been selected in the device list.
v Chapter 5.1 "Editing the Device List"
By clicking on button
you can inhibit the start of automatic mode.
Thus you have the oportunity to change the settings of automatic devices before starting automatic mode manually.
With button
you can start automatic mode immediately, i. e. before
waiting time has expired.
If you do nothing, automatic mode is started after the expiration of waiting time.

Automatic mode
– do not start
Automatic mode
– start

H

The dialog is not started if function "Automatic in background" is
active when the program is started or if PCC has been started as a
Windows system service.
v Chapter 8.4.2 "Automatic Mode in Background"
v Chapter 8.4.4 "Start as service"
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4 Operation
4.2

Windows of the User Interface

Navigation tree
A tree structure showing
all connected devices
Output orders window
Point in time and number
of output orders per
device

Active devices window
A list of all the devices that are
active (in PCC) at present, e.g.
retrieving data
Dialog window
The settings for the connected devices
are listed here.

The mouse can be used to adjust the window to the required size.
The windows for active devices and output orders can be shown or hidden.
v Chapter 8.7 "Window"

16

4 Operation
4.3

Device types
Devices with or without CompactFlash memory card or USB host
interface

H

The operating instructions below make frequent reference to
“Device type” 1 or 2 or to “Devices of type” 1 or 2.
Device type 1
Device type 1 designates devices that have no slot for
CompactFlash memory cards and no USB host interface.
These are, for example, LOGOSCREEN, LOGOSCREEN 500,
IMAGO 500 or IMAGO F3000.
Device type 2
Device type 2 designates devices that are equipped with a slot for
CompactFlash memory cards or a USB host interface for
connecting a USB memory stick.
These
are,
for
example,
LOGOSCREEN 500 cf,
LOGOSCREEN es,
LOGOSCREEN cf and LOGOSCREEN nt.
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4 Operation
4.4

Rights
As described in “Logging in to the program” on page 13, a user must log in with
the correct ID and password under some circumstances when the program is
started. As a result of this, log-in rights are assigned to individual functions.
Therefore it may not be possible to activate all functions, depending on the user
or type of installation.

Enhanced
security level

For the PC software with an enhanced security level, rights and users are
assigned and managed by an administrator, using the PC Security Manager
software (PCS).

Standard

In the case of PC software without an enhanced security level, rights and
users are fixed.
Right

Demo
installation

Maintenance

Specialist

Edit time settings

-

-

X

Edit archive settings

-

-

X

Print

-

X

X

Edit interface settings

-

X

X

Edit device settings

X

X

X

Delete device

-

-

X

Create new device

X

-

X

Start automatic mode,
start PCC as service

-

-

X

Exit Start automatic mode,
exit PCC as service

-

-

X

Pause transmission procedure

-

-

X

Edit extras/options

-

X

X

Edit global settings

-

X

X

Place program in background /
bring to foreground

-

-

X

View event list

X

X

X

View error list

X

X

X

Comment in audit trail

-

X

X

Preparing the device modem

-

X

X

Enabling program options

X

-

X

Create new archive

-

-

X

Read in time periods

-

X

X

X = right is available
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4 Operation
4.5

Navigation tree
The settings for the device list are made in the navigation tree, where the
individual devices (from which the data are to be read out) are entered.
Fold up tree ( )
and
unfold tree ( ).

Use the mouse to change the settings in the device list or to add a device to the
list.
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4 Operation
4.6

Dialog window
The currently valid entries are shown in the dialog window. The dialogs for
altering the settings can also be called up in the dialog window.

Click on the arrows (by using the left mouse button when the mouse pointer is
positioned on an arrow) to open (unfold) and close (fold up) the current
parameter values.
Unfold /
Fold up

Device list

Use the right mouse button, or double-click the device list to change the global
settings.

v Chapter 5.1 "Editing the Device List"
v Chapter 8.2.1 "Device List"

20

4 Operation
Device type
(device)

Right click or double click a device to change all the settings for the device. If
the function “Use the Assistant for device settings” is active, then all the
settings will be requested, one after another. If the Assistant is not active, you
will have to call up the various settings dialogs by hand.

v Chapter 5.2 "Adding devices"
v Chapter 8.2.2 "Device Type"
Device type
(parameter)

You can right click or double click a parameter to change a particular setting for
the device (the Assistant for device settings doesn’t matter in this case).

v Chapter 5.2 "Adding devices"
v Chapter 8.2.2 "Device Type"
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4 Operation
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5 Device Management
5.1

Editing the Device List
h Position the mouse pointer on “Device list” and press the right mouse
button.
A new device is
entered in the list
here.
Alter the global
settings for the
device list.

Global
settings

h Select function Edit device list.
Descriptive text. This appears in the dialog window and
is also printed out.

Default directory for
archive data that has

Settings for e-mail
messaging.
Use the default directory (created within the PCA3000
software) or specify a different directory.
Either “Use the Assistant for device settings” or enter
everything by hand. If the Assistant is active, all the
necessary parameters will be requested one after another.
Automatic mode is activated automatically after the program
starts. Automatic mode can also be activated manually.
Messaging via e-mail is active.

v Chapter 8.2.1 "Device List"
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5 Device Management
E-mail
settings

Settings for e-mail messaging.
Selection of different possibilities for (optionally) logging into
the e-mail server
User name and password for logging
in on the e-mail server
After you click the button, you can make settings
for the SMTP and if applicable the POP3 server.
Information about the sender, used
in the e-mail

Regardless of the daily status A status message is sent daily
message, an e-mail is sent
by e-mail at this time (with
when an error occurs.
automatic mode).
Other errors are only reported
if they occur after an
adjustable amount of time (in After the server data and an ethis case 10 minutes).
mail address are entered, a test
e-mail can be sent.

E-mail addresses and topic
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5 Device Management
Server
settings

Settings for SMTP server or POP3 server.

IP address or host name of the
SMTP or POP3 server.
When the host name is entered, the
IP address can be determined by
clicking "Convert host name to
IP address“
(for information or to check
whether the host name can be
converted into an IP address).

H
5.2

Port number or port name for the
SMTP or POP3 service.
The port name is replaced while the
connection is being set up by the
predefined port number
(SMTP = 25; POP3 = 110).

E-mail is sent via the SMTP server. The settings for the POP3
server are only needed if login is required on the e-mail server and
the server uses the "SMTP-after-POP“ procedure for
authentication.
You can obtain all necessary settings (IP address, port number,
login data) from the operator of the e-mail server.

Adding devices
h Click a device to activate it.

h Start the menu function Edit ➔ New or click the icon (

) in the toolbar.

The following text example assumes that the selected device is a paperless
recorder.
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5 Device Management
Select device

The following dialog appears if the setting "Use the Assistant for device
settings" is active.
Select device type and version.
Select device group / machine line to which the device
shall be assigned to. (This drop-down-menu is only
visible if there are at least two device lists.)
Selection of connection presettings
(device-dependent)

If the option is active ( ),
a check is made at the end,
whether the chosen device can
be accessed via the selected
interface.

The identifier is created by the
computer. It is unique, and is,
forexample, entered in the PC audit
trail.
It can be used in the PCAT software,
if a filter is defined.
A descriptive text for the device can be
entered here. The text will appear in the
navigation tree.

H

The function described here is based on an active “Assistant for
setting devices” (default setting for a new software installation). The
Assistant can be switched off through the function Device list ➔
Edit or by using the Setup or PCS software within the device list.

You will now be led automatically from dialog to dialog, and can make all the
entries that are required for reading out data.

26

5 Device Management
Logging in on
the device

Logging in to the device is only required for devices with internal user
administration (e.g. LOGOSCREEN cf).

Save ID and password
Do not log in

Do not
log in

The default setting of the software is that a user who is logged in is
automatically logged in to a device that is found with the user’s name and
password, and can thus communicate with this device.
Set option ( ) if you do not want to log in. Please note that, for example, the
following functions are not executable if you are not logged in (standard
setting):
- Fetch data
- Read data
In the device’s user list it is defined by standard rights which functions can be
executed by a user who is not logged in.

Save ID and
password

If the option is active, the log-in to the device is made through the user ID and
password that are entered, regardless of who is currently using the PC
software.

In the following dialog window, click
to use to access the device.

to select the interface you want
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5 Device Management
PC
Communication
interface

Available options are:
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USB

Setup interface

USB

USB

RS232

RS232

RS232

RS232 to
RS422/485
converter

RS232

Setup interface

Modem

Modem - RS232

Modem

Modem - RS422/485

5 Device Management
TCP-IP
(Intranet / Internet)

Ethernet

TCP-IP
(Intranet / Internet)

TCP-IP to
RS232/RS485
converter
type: I-7188E series

TCP-IP
(Intranet / Internet)

TCP-IP Ethernet to
RS232/RS485
converter
type: W&T Com server

The next steps depend on the interface or type of connection that has been
selected.
USB-TTL
converter

USB
interface

The following parameters must be selected:
Connected
TTL converters

Select converter

If multiple converters are
connected, a selection
can be made here.

Transfer rate

9600, 19200, 38400

The transfer rate must
match the one that has
been set in the device.

Device address

1 … 254

Device address for the
Modbus protocol

The following parameters must/can be selected:
Communication
protocol

Modbus protocol

The Modbus protocol
must be set here.

Connected devices

Select which device
should be connected.

If multiple devices are
connected via USB
interface, a device can
be selected here.

Name

Activate check
yes/no

If check is active, the
device will only be
connected if the device
name matches.

F No.

Activate check
yes/no

If check is active, the
device will only be
connected if the device
number matches.
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5 Device Management

Serial
interface

CPU

Activate check
yes/no

If check is active, the
device will only be
connected if the CPU
number matches.

Path

Activate check
yes/no

If check is active, the
device will only be
connected if the USB
path matches.

The following parameters must be selected.
Connected to

COM1, COM2

The PC interface to
which the device is
connected.

Transfer rate

9600, 19200, 38400

The transfer rate must
match the one that has
been set in the device.

Control signal

RS232

If the RS232 interface
on the device or an
interface converter with
an automatic transmit/
receive changeover is
used.

RS232 setup interface
(TTL)

If the setup interface on
the device is used.

RS422-RTS

If the RS422/485
interface on the device
is used.

RS422-DTR
RS485-RTS
RS485-DTR

Recommendation: Use
a Spectra converter with
an automatic transmit/
receive changeover.

Communication
protocol

Modbus protocol

The
Modbus protocol
must be set here.

Device address

1 … 254

Device address for the
Modbus protocol.
If the “RS232 setup
interface” is used as the
control signal, then the
device address is
ignored – it does not
have to match the
address in the device.
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5 Device Management
Analog
modem /
ISDN

TCP/IP PORT

The following parameters must be selected.
Telephone number

Enter the telephone
number for the required
device.

Connect via

Select the modem that
will be used to make the
connection.

Communication
protocol

Modbus protocol

The
Modbus protocol
must be set here.

Device address

1 … 254

Device address for the
Modbus protocol.

The following parameters must be selected.
IP address /
HOST name

xxx.xxx.xxx.xxx
(Example:
192.168.0.10)

Specify the IP address
or the host name of your
device. (If the host name
is used, the IP address
can be determined for
verification by clicking
"Convert host name to
IP address".)

Port number,
port name

502,
80

Port used for
communication
(protocol-dependent).
Modbus-TCP/IP -> 502
Http protocol -> 80

Communication
protocol

Modbus TCP/IP,
Http protocol

The
Modbus TCP/IP or
Http protocol
must be set here.
Note the port number!
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5 Device Management
TCP/IP PORT
(ICPDAS
7188E1-8)

The following parameters must be selected.
IP address /
HOST name

xxx.xxx.xxx.xxx
(Example:
192.168.0.10)

Specify the IP address
or the host name of your
device. (If the host name
is used, the IP address
can be determined for
verification by clicking
"Convert host name to
IP address".)

Serial port

COM1, COM2, ...

Serial port of the
converter to which the
device is connected.

Transmission rate
(baud rate)

9600, 19200, 38400

Transmission rate
between converter and
device. It must match
the rate set in the
device.

Control signal

None

If the RS232 interface
on the device is used.

RTS permanent
RTS changing
TCP/IP PORT
(W&T)
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The following parameters must be selected.
IP address /
HOST name

xxx.xxx.xxx.xxx
(Example:
192.168.0.10)

Specify the IP address
or the host name of your
device. (If the host name
is used, the IP address
can be determined for
verification by clicking
"Convert host name to
IP address".)

Serial port

A, B, C, D

Serial port of the
converter to which the
device is connected.

Transmission rate
(baud rate)

300, 600, 1200, 2400,
4800, 9600, 14400,
19200, 38400, 57600

Transmission rate
between converter and
device. It must match
the rate set in the
device.

5 Device Management
Control signal

RS232

If the RS232 interface
on the device is used.

RS232 setup interface
(TTL)

If the setup interface on
the device is used.

RS422-RTS

If the RS422/485
interface on the device
is used.

RS422-DTR
RS485-RTS
RS485-DTR

RS232/RS485
adapter cable

Recommendation: Use
a Spectra converter with
an automatic transmit/
receive changeover.
Only for internal
test purposes.

After selecting the interface, the next step is to make the entries for the time
settings (for the automatic read-out of data) and the archives (folders and
names of the files in which the data will be stored).

H

Not all devices support setting up a connection via the setup
interface. In this case, please use another interface on the device in
question.

H

Please consult the Operating Instructions of the relevant device for
information about connecting and configuring the interface on the
device.

H

The connection to a device of type LOGOSCREEN nt can also be
made via Internet.
v Chapter 5.6 "Connection via PROXY server"
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5 Device Management
Time
settings

h After you click the
automatic read-out.

button, you can enter the times for the

Click OK when the times have
been set.
v Chapter 6 "Time Settings"
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5 Device Management
Archive

h After you click the
button, you can alter the settings for the archive
(file name and directory).

When the archive settings are
complete, click OK.
v Chapter 7 "Archive"
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5 Device Management
You will then get a summary for the new device.

h Click

to finish adding a new device.

The device should now be set up and ready for reading out data. If you want
the device to read out data automatically, automatic mode must be started. It
can be started through menu function Automatic ➔ Automatic mode.
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5 Device Management
5.3

Changing the settings
h Position the mouse pointer on the

icon and press the left mouse button.

The tree in the navigation window unfolds.

h Position the mouse pointer on the parameter group you want to change, and
right click.

h Select “... Edit.” The corresponding dialog for making changes opens,
depending on the selected parameter group.
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5 Device Management
In this example, the "Time settings" dialog appears.

v Chapter 6 "Time Settings"
v Chapter 8.2.3 "Editing"

5.4

Device list sorting
You can sort the device by moving devices within their device type. It is also
possible to move device types within the device list.
To sort the device list, follow these steps:
h Mark the device type or device with the mouse pointer.
h Click the appropriate icon to move the device type or device:
up
down
More information on managing devices may be found in the following sections:
v Chapter 8.2 "Editing"
v Chapter 8.5 "Tools"
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5 Device Management
5.5

Creating additional device lists
The default device list is named “device list“. This name can be changed. In
addition further device lists can be created and their names can freely be
chosen.
v Chapter 8.2.4 "Device groups/Machine lines"
Using several device lists has the advantage that devices can be grouped
together or assigned to machine lines.
Each device list is displayed in a separate window. The following example
shows two device lists named „Oven“ and „Boiler“.

5.6

Connection via PROXY server
Connecting a LOGOSCREEN nt device via Internet means that a PROXY
server has to be used. Without PROXY server it is only possible to use a VPN
connection or a connection within an Intranet.
When you add a new device to a device list, it is best to use the Assistant for
setting devices and to choose the corresponding connection presetting. Thus
in the TCP/IP port settings window you will find additional input fields for
PROXY server.
v See “With assistant” on page 40.
You may first have to change the Extended settings for communication in order
to make the PROXY server input fields visible.
v See “Changing the extended settings” on page 40.
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5 Device Management
With assistant

Enter IP address
(or host name)
of device

Enter port number
of PROXY server

Enter IP address (or name)
of PROXY server
Changing the
extended
settings

You can change connection properties for entering IP address and port number
of the PROXY server as follows:
h Click on Features within Connection window. In the next window click on Expanded...
The following window is opened:

h Select „HW:Connect via a PROXY“, set the new value to 1 and finish the
dialog with OK.
h Also close the previous window with OK.
h Once again, click on Features.
In the next window the additional input fields for PROXY server are visible
now..

H
40

The connection via PROXY server in only working with settings
TCP-IP-Port and Http protocol.

6 Time Settings
In the “Time settings” dialog, you can set the cycle types for retrieving data,
synchronizing clocks, operating times for each day of the week, and the
settings for the response to an error. Here you can also make settings to define
how data is read out and evaluated.
The menu for setting the times for retrieving data can be accessed
- when a new device is set up or
- by means of the menu function Edit ➔ ... Times: - Edit.
In the latter case, the “Times” field must be selected in the navigation tree.

When you click

, additional setting options appear.
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6 Time Settings

A
I

It depends on the specific device whether, when
connection via TCP/IP, only one program from
components can operate through the interface. If
can operate, other programs can still continue to
other devices.

using an Ethernet
the PC software
only one program
communicate with

Example:
PCC is used to access a paperless recorder (Device 1) via TCP/IP.
PCS (Security Manager) can be used to access a different paperless
recorder (Device 2) via TCP/IP.

Cycle type:
Periodic

Defines the type and method for retrieving or reading out raw data.
Active ( ):
Data will only be read; the memory alarm
is not affected

The following functions
are available:

Setting for retrieval intervals:
The settings “2” and “hours” mean:
data will be retrieved every 2 hours

Inactive ( ):
The time interval does not start to run
until the read-out procedure is finished.
Active ( ):
The time interval starts to run at the start
of read-out.
If the read-out takes longer than the time
interval, then the next whole multiple of
the interval is used.

Operating period: active
Inactive ( ):
The operating period is the relevant factor for the time interval. At the end of the
operating period, the remaining time of an interval is carried forwards to the start of
the next operating period.
Active ( ):
At the end of the operating period, the interval continues in a 24-hour rhythm.
Operating period: inactive
If the operating period is inactive, this function has no effect.
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6 Time Settings

H

Example 1

If the period is set to less than 60 seconds, the data are read out in
a continuous cycle, i.e. the connection to the device is never
broken. A continuous cycle is only stopped if an error occurs, on
cancellation by the user, or at the end of the operating period (if it is
active and the read-out has been carried out 100%). The parameter
for “Continue read-out beyond the operating period” in the
“Advanced (1)” tab also has an effect on the end of the operating
period.

The interval for retrieval is: every 2 hours during the operating period from
08:00:00 AM to 06:00:00 PM, with the setting “Immediate”. In this case, the
operating period can be divided by the time interval.
11:05:32

13:05:32

actual time
09:05:32

H
Example 2

15:05:32

17:05:32
time
operating period 08:00 to 18:00

If the option “Use period as absolute time” was active ( ), then the
behavior would not change, since both the operating period (10 h) and
a complete day (24 h) can be divided by the time interval (2 h).

The interval for retrieval is every 2 hours during the operating period from
08:30:00 AM to 05:30:00 PM, with the setting “Immediate”. In this case, the
operating period cannot be divided exactly by the time interval. So the retrieval
times for the following day will be shifted accordingly.
When data is retrieved for the 10th time, the start time will have come round to
09:05:32 again.
7.
2.

3.

6.

8.

actual time
09:05:32

4.

9.

H

5.
time for fetch
operating period 08:00 to 18:00

If the “Use period as absolute time” option was active ( ), then the
behavior for read-out would be as described above, for Example 1.
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6 Time Settings

Start time for next read-out of data
No change
If a change is made to the time settings, the new time will only take effect after the
next read-out.
Example: Read out will be performed Mondays at 8:00 AM. It is currently 7:00 AM
Monday. You set “Retrieve at” to 10:00 AM and leave the “Calculation of start date”
set to “No change.” The next read-out happens at 08:00 AM. Then the new setting
will be made for 10:00 on Monday of the following week.
Next valid date:
Depending on the setting, this is the next full hour, minute, or day – at
00:00:00 AM.
Immediate:
This takes the present day/time as the starting date, after which the new time is
calculated from the current setting. Caution: If the present time is outside the
operating period, there will be no read-out.

Cycle type
Daily,
Weekly,
Monthly

Time
for daily, weekly or monthly
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Weekday
for weekly or monthly

6 Time Settings
Time
synchronization

The setting for when the device time will be synchronized to the PC time. This
is used to eliminate differences between the PC and the device.

H

It is only possible for devices that support time synchronization.

H

Synchronization can only be performed during operating periods.

Setting that determines whether and how the start date/
time is calculated

Cyclic
check

This defines a check for whether the attached device is still connected to the
PC. If a device is not accessible, then an error message is entered in Audit Trail
Manager.

Setting for how frequently the connection should be
checked.

This function is intended to reveal any possible connection error before the
data read-out takes place.

H

The check can only be made during the operating period
(when the operating period is active).
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6 Time Settings
Operating
periods

Here you can set the periods of time for which the device is accessible, i.e. the
system is in operation. These settings are used to calculate the start dates/
times for activities (e.g. retrieving or reading out data, time synchronization,
and cyclic checks) and in this way also reserve specific time periods for other
programs.

Weekdays on
which the
device will be
operational

The time of
day from ... to
... when the
device is
operational

Daily times

These settings are intended for use when data need to be retrieved or read out
at a specific time of day.

A

These times must lie within the operating periods, and
the action (retrieving/reading) must be set to daily!

List for the
special time
entries

Time
entry

The selected entry is removed from the list
and presented for editing in the time field.
Adds the date/time that is set to the list.
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6 Time Settings
Time schedule

These settings are intended for use when data must be retrieved or read out at
individually specified times that cannot be set to occur periodically.

A

These times must lie within the operating periods, and the action
(retrieving/reading) must be set to schedule! After the processing of a
scheduled event, it will be removed from the list by the software.

List for the
special time
entries

Time
and date
entry.

The selected entry is removed from the list
and presented for editing in the date/time
field.
Adds the date/time that is set to the list.
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6 Time Settings
Expanded (1)

A

This function depends on the device version!

Inactive ( ):
All data will be read out from the device. For Type 1
devices (e.g. IMAGO 500) it can happen that a memory
alarm is generated during the read-out. After a successful read-out, the alarm will automatically be reset.
Active ( ):
Only new data will be read, even if “old” data is still
missing in the archive.

Response
to error

% of data not
yet retrieved
(only for
Type 1
devices)

Active ( ):
The mark that data have been retrieved
will only be set when the read-out procedure is finished (only Type 2 devices).
Active ( ):
If the operating period ends, an existing read-out procedure continues until all the data have been retrieved.
Inactive ( ):
If the operating period ends, an existing read-out procedure is cancelled (after the current data block has been
completely read out).
Active ( ):
In the event of an error, a single repeat is carried out. Further
attempts at reading will not be made until the next scheduled
time.
Active ( ):
In the event of an error, repeats are permitted even
though they are made outside the operating period.
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6 Time Settings
Expanded (2)

Active ( ):
The scheduled times are calculated from the next valid
point, as if the PCC software had just made a read-out.
Inactive ( ):
Data that have not yet been read out (from devices
where the scheduled time has passed) is read
immediately and then the scheduled times are
recalculated (see register for operating periods).
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6 Time Settings
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7 Archive
The menu for setting the archives for retrieved data can be accessed
- when a new device is set up or
- by means of the menu function Edit ➔ Edit archive.
In the latter case, the “Archive” field must be selected in the navigation tree.
After calling up this function, the default archives that have been set will
appear, and the other functions will be grayed out (not selectable).

A new archive can only be set if the tick mark is removed by clicking. You can
select any directory and/or archive file with the *.177 filename extension.
Tip

It is a good idea to have several archive files if the data will be stored both on
your own PC and on a server, using a regular data backup procedure. For
instance, an additional archive could be provided for company-wide access.
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7 Archive
Current default archive (directory)
v Chapter 8.1.5 "Default Settings"

Click (with the left
mouse button) to
start the
PCA3000
software and
bring up the
archive data in
the display.
If there are
several archive
files in the
directory for a
device, then the
first archive that
is found will be
used.

Archives for
automatically read data

Archives for manually
read data

Changing archive automatically
v Page 54
Using an output form
v Page 54
Active ( ):
Data is immediately accepted for evaluation.
In PCA3000, this means that the archives will be opened faster.
Active ( ):
Accepts each data block individually for evaluation, directly after reading out.
Inactive ( ):
All the data in the archive that is not yet in evaluation (e.g. previously read
data, or data from a CF card) will not be evaluated until the end of reading
out.

A
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Archive directory:
Data is saved in all archive files with the same device identifier (Manf. No.,
CPU No., or config checksum; depends on device type). If there is no
archive, a new one will be created.
File name = device identifier
Archive file:
Data will only be stored in this archive. The archive must have the same
device identifier as the device itself. If the archive does not match the device
and no matching password is found, a new one is created.
If, for instance, it is not possible to store data on a network, it will be stored in
the default archive.

7 Archive
If the standard archive paths (or archives) shall not be used, the concerning
function has to be deactivated ( ). Example:

Inactive:
Archives for automatically
read data will not be used for
manually read data.
Inactive:
The default archive path for
manual read-out will not be
used.

Double clicking on it
allows you to enter the
name directly.

Add another archive for
manually read data.
Edit archive entry for manually
read data.
Remove an archive from the list.

Start PCA3000 and display the data.
The marked archive will be opened. If it is a directory, then the
first archive that is found will be opened.

Tip

If you click a second time on an entry (not a double-click; two clicks with brief
pause between), you can edit the archive name and the directory as text.

Tip

If you enter a name without defining a path (e.g. Manual01.177), then an
archive with this name will always be created or used in the default directory.

A

When making a manual entry, please note that the file name extension
must always be “177.” If this rule is not followed, it will not be possible
to store data in the intended archive.
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7 Archive
Changing
archive

When the set time range is exceeded, a new archive is automatically created.
The following settings are possible:
- inactive
- 1 day
- 1 week
- 1 month
- 1 year

H
Output
form

54

The time range refers to the time stamps in the data of the device. It
does not refer to the points in time when data are read or fetched
from the device.
Therefore an archive change is not possible until device data with a
corresponding time stamp are available. In this respect the point in
time when data are read or fetched is also relevant.

Data that have just been read in are automatically generated with the form
selected here.
This function can only be used if PC Evaluation software PCA3000 has been
installed with option "automatic printout."
Further information can be found in the documentation for PC Evaluation
software PCA3000 (B70.9701.0).

8 Menu Functions and Toolbar
8.1

File

8.1.1 Export as RTF Text
This function exports the information in the dialog window as an RTF text in the
file to be selected.

8.1.2 Print, Print Preview
This function

prints all the connection data for the devices marked in the

diagram in the dialog window.
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8 Menu Functions and Toolbar
Print preview

8.1.3 Printer Setup
This switches to the list of printers installed on the PC.
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8 Menu Functions and Toolbar
8.1.4 Output orders
When outputs have been stopped (tick mark visible), data are no longer output
into output forms. Nevertheless, outputs will not be lost because they are
entered on a list with output orders.
In this case, after manual read out, the automatic start of PC Evalution software
PCA3000 is also deactivated (manual start by using button is possible).
In the window for output oders every device is shown with time and number of
outputs (e. g. batches):

v Chapter 4.2 "Windows of the User Interface"
After enabling outputs (tick mark removed), all outputs, which have been collected till then, are carried out. PCA3000 is started automatically if manual read
out was used before.
The list with output orders can also increase even if outputs have not been
stopped. This happens temporarily when outputs cannot be processed as fast
as they are collected.

8.1.5 Default Settings
h File ➔ Default settings
h Set the preferred language and font
A tick mark means that
this bar or line is
visible

You can select the language of the PC program here as well as the font for
printer output.
The settings do not become active until the program has been restarted.
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8 Menu Functions and Toolbar
8.1.6 List Settings
Right-click on
the device list

You can enter
additional information
on the list in this field.
The default PCA3000
archive is used. - Do
not set a tick if another
archive directory is
required.

Device settings are
made with the
Assistant.
Automatic mode is
active after the
program starts.
Messaging via e-mail
is activated.
Click here to select a different archive
(instead of the default archive for PCA3000)
or to enter the name directly
in the field.
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8 Menu Functions and Toolbar
8.1.7 Exit
This terminates the program immediately after any current activities, such as
reading out data, have been completed. During the time that elapses until all
activities have been completed, no new activities will be started. Activities of
connected devices can also be cancelled. In this case, the program is
immediately terminated.

If any devices are still active after clicking
out), then the following dialog will appear.

Click the upper button

(e.g. data are being read

for the lower ones to become active.

Select "Stop all" to end the program immediately.
If you select "All delayed", the program ends as soon as all currently active data
blocks have been completely read

A

If a data transfer is cancelled prematurely, then some data will be
missing from the archive. You must make certain that the data has
been retrieved from the devices in good time, before a loss of data
occurs.

59

8 Menu Functions and Toolbar
8.2

Editing
The entry in the navigation tree defines which of the functions New, Edit,
Duplicate, and Remove are available.

Device list

If the device list item is active, then the following functions are available.

v Additional information can be found in Chapter 8.2.1 "Device List".
Device type

If a device type (e.g. LOGOSCREEN es/cf) is active, then the following
functions are available.

v Additional information can be found in Chapter 8.2.2 "Device Type".
Device

If a device is active, then the following functions are available.

Parameter
group

If the parameter group for a device is active, then the following functions are
available.

v Additional information can be found in Chapter 8.2.3 "Editing".
Device groups/
Machine lines

The function Device groups/Machine line is always available, regardless of the
entry which is currently marked in the navigation tree.

v Additional information in Chapter 8.2.4 "Device groups/Machine lines".
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8 Menu Functions and Toolbar
8.2.1 Device List
Editing the
device list

h Edit ➔ Device list: - Edit (or press the F4 function key)

Remove

h Edit ➔ [Device]: - Remove (or press the “Del” key)

The entry marked in the tree structure will be edited.
v Chapter 8.1.6 "List Settings"

This removes a connected device from the device list.

h Click on “Yes” to remove the entry from the device list.
Duplicate

h Edit ➔ [Device]: - Duplicate (or press “Ctrl” + “Insert” keys)
The device that is marked in the navigation tree will be copied, and added to
the device list as a new entry. This entry can be freely modified.
A new identifier is created for every device entry, and so it is different from the
device that was copied. Events and errors are not copied, but automatically set
up as new entries.

H

This function is particularly suitable as a time-saver for entering
devices that are similar, with only small differences in the connection
data.

v Chapter 8.2.2 "Device Type"
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Move a device
to another
device list

h Create a new device list if necessary
v Chapter 8.2.4 "Device groups/Machine lines"
h Mark the device in the navigation tree
h Edit ➔ [Device]: - Edit (or press the F4 function key)
h Select the required device list in field Device group / machine line
h Finish dialog (OK or Forward... ; depending on dialog)
The device is moved to the selected device list.

8.2.2 Device Type
New
(with Assistant)

New
(without
Assistant)

h Edit ➔ New (or press the “Insert” key)
This adds a new device to the device list.
v Chapter 5.2 "Adding devices"
h Edit ➔ New (or press the “Insert” key)
New devices can also be added to the device list without using the “Assistant
for device settings”.
When you have called up the function, the following dialog window will appear:

Unlike the operation with the Assistant, you will not be led sequentially from
one parameter to another, but will have to start the individual dialog windows
yourself.
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8 Menu Functions and Toolbar
8.2.3 Editing
Edit
connection

h Edit ➔ ... Connection: - Edit (or press the F4 function key)

The “Return call” function is only
available for specific device types with
an active modem connection (e.g. for
the IMAGO 500 controller). Here you
must enter the number of the PC that
will be called by the device.

The log-in options have already been described on Page 27.
If you click
connection.

Edit
times
Edit
archive

, you can alter the settings for the communication

h Edit ➔ ... Times: - Edit (or press the F4 function key)
v Chapter 6 "Time Settings"
h Edit ➔ ... Archive: - Edit (or press the F4 function key)
v Chapter 7 "Archive"
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8 Menu Functions and Toolbar
Edit
Teleservice

Edit ➔ ... Teleservice: - Edit (or press the F4 function key)
The cycle time determines the interval for updating the display. The font size
determines the size for display of the Teleservice window.

Editing
events

h Edit ➔ ... Events: - Edit (or press the F4 function key)
The “Events” list is designed for fast diagnostics and checking. Events that
have been entered here can be deleted. However, deleting them has no effect
on the Audit Trail entries.

The number of entries is limited. If the maximum number is exceeded, the
program will delete the oldest entries. You can use the PCAT software to view
all the entries.
Editing
errors

h Edit ➔ ... Errors: - Edit (or press the F4 function key)
The “Errors” list is designed for fast diagnostics and checking. The errors that
have been entered here can be deleted. However, deleting them has no effect
on the Audit Trail entries.

The number of entries is limited. If the maximum number is exceeded, the
program will delete the oldest entries. You can use the PCAT software to view
all the entries.
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8 Menu Functions and Toolbar
Error
indication

The toolbar contains two bell icons for indicating errors.
The green bell

becomes active if a new error occurs in the device that is

marked in the navigation tree.
The red bell

becomes active if a new error occurs for any device.

If errors occur in more than one device, the bells remain active until you have
looked at all the errors.

H

The number of different devices with new errors is limited.

8.2.4 Device groups/Machine lines
Edit ➔ Device groups/Machine lines
This function can be used to create new device lists or to rename or remove existing device lists.

A name has to be given to a new device list in the following field. If an existing
device list shall be renamed, this has also to be done here.

A device list can only be removed if it does not contain any device. If the list is
not empty you first have to remove all devices or to move the devices to
another device list.
v Chapter 8.2.1 "Device List"

65

8 Menu Functions and Toolbar
8.3

Data Transfer

8.3.1 Reading out Raw Data (Manually)
Depending on the device that is used, different information must be provided
when manually reading out
LOGOSCREEN
500cf/es/cf/nt

raw data.

For
devices
of
type
LOGOSCREEN 500 cf,
LOGOSCREEN es,
LOGOSCREEN cf and LOGOSCREEN nt (device type 2) you can set what
data is required by the device.

H

The value for the memory alarm is not affected, i.e. the data will be
read out, but not marked as “retrieved”!

First, the software establishes a connection to the device.

You can close the dialog (or move it) and carry on working through the PCC
software. When the connection has been established, the data selection
follows. Every change to the configuration requires a new entry to be made in
the list.
For example if the configuration of a measurement input is changed, then a
new entry has to be made, because different measuring ranges require
different scalings in PCA3000.
h Select the required entry from the list and set the time limits if necessary.
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8 Menu Functions and Toolbar
The archive is selected here.

Active ( ):
After reading out the data, the evaluation software
PCA3000 will be started automatically (if outputs are not
stopped).
The first archive that is found will be opened, depending
on the settings described under „Edit archive” on
page 63.

v Additional information about using the data selection dialog can be found in
the PCA3000 Operating Manual (B 70.9701.0).
IMAGO 500

Another example of a device is the multi-channel process and program
controller IMAGO 500. For this device, it is only necessary to define the amount
of data to be read out as a percentage.

Active ( ):
After reading out the data, the evaluation software
PCA3000 will be started automatically (if outputs are not
stopped).
The first archive that is found will be opened, depending
on the settings described under „Edit archive” on
page 63.
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8 Menu Functions and Toolbar
8.3.2 Fetching Raw Data (Manually)
When raw data is fetched manually

, a check in the device determines

what data is not yet in the set archive.
This command transfers only the data that is missing to the archive.

H

The value for the memory alarm is reset and marked as “fetched”!
For Type 1 devices, please note the Times ➔ Advanced (1) tab
(Page 48).

h Click the icon.
The missing data will be transferred to the selected archive in the PC.

H

Device type 2
Depending on the time taken for reading out and the speed of
storage, it is possible that data has been recorded after the start of
reading out, but not yet been read out. This data will be retrieved by
the next read-out procedure.
Device type 1
Data recorded after the start of reading out will be retrieved by the
next read-out procedure.
All device types
If manual retrieval has lasted for longer than 1 minute, automatic
read-out is performed again, and if necessary once more after that
(for a maximum of 3 times).

8.3.3 Canceling the Procedure
The

function is used to cancel a currently active process of the device

identified in the tree structure immediately.
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8 Menu Functions and Toolbar
Cancel
automatic
mode

If you are about to cancel the read-out of data in automatic mode, the following
dialog window appears:

The procedure that was cancelled
will be resumed at the earliest after
this time has elapsed. Automatic
mode must remain switched on!

Click
to cancel the reading out of data immediately. Make sure
that the data have been retrieved in good time, to avoid a loss of data. Select
the period during which the device will remain inactive. Automatic mode will not
restart for the selected device until that period has elapsed.
After you click
, read-out ends as soon as the currently active
data block has been completely read. In this case, no error message will be
generated.
Cancel
manual
read-out

When you cancel a manual read-out, the following dialog window appears:

Click
above).
PCAT entry

or

to cancel the reading out of data (see

Cancelling automatic mode or manual read-out will cause the following PC-Audit-Trail entries:
Yes, immediately: Error
Delayed: Warning

H

The appropriate user rights are required to cancel reading out of
data.
v Chapter 4.4 "Rights"
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8 Menu Functions and Toolbar
8.3.4 Teleservice
Teleservice

is used to show current process data of attached devices.

Teleservice can be active for several devices at the same time.
The interval at which data is updated can be adjusted. The font size can also
be changed.
v „Edit Teleservice” on page 64

H
H

Exit
Teleservice

70

To use Teleservice,
"Modbus" or "Modbus TCP/IP" must be set as the connection
protocol.

Manual read-out or retrieval of data is not possible when Teleservice
is active.
The active Teleservice is closed for an automatic device if data is
being read out or retrieved.
If data needs to be read out or retrieved from a given device at the
same time Teleservice is active, two copies of Teleservice must be
present in the device list (use function "Duplicate").

An active Teleservice session can be terminated for the selected device
(- Exit Teleservice) or for all devices (Exit all Teleservices).

8 Menu Functions and Toolbar
8.4

Automatic
The scheduled times and activities that have been set up under “Times” will
only be automatically processed in automatic mode.

8.4.1 Starting/Stopping Automatic Mode
You can tell whether automatic mode has been started by whether the icon
appears depressed.
If automatic mode has been stopped, the icon is shown as normal, i.e. not
depressed
Changeover
started/
stopped

.

The changeover between started and stopped is made through the menu
function Automatic ➔ Automatic mode or by clicking the corresponding icon
.

8.4.2 Automatic Mode in Background
This closes the current program window and places the PCC icon in the system
tray of the task bar at bottom right. The program carries on running in the
background.

If the program is ended and then restarted, it carries on in the background, as
shown in the picture. If the PC is restarted, then PCC is also automatically
restarted (after logging in to the operating system).
h If you click the icon, a window opens.
h Click “Program in foreground” and then (after successful user log-in) PCC
reopens the program window to its full size.
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8 Menu Functions and Toolbar
8.4.3 Stopping Active Devices
This function

terminates automatic mode (if it was active when the icon

was clicked) and cancels all currently active data transmissions.

Message for
active
automatic mode

Cancel current
transmissions

Click the upper button

for the lower ones to become active.

Select "Stop all" to end the read-out immediately.
If you select "All delayed", the read-out ends as soon as all currently active data
blocks have been completely read. In this case, no error message will be
generated.

A
PCAT entry
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If a data transfer is cancelled prematurely, then some data will be
missing from the archive. You must make certain that the data has
been retrieved from the devices in good time, before a loss of data
occurs.

Cancelling current transmissions will cause the following PC-Audit-Trail entries:
Stop all: Error
All delayed: Warning

8 Menu Functions and Toolbar
8.4.4 Start as service
Starts PCC as a Windows system service.

User name and
password of the
Windows user

This function makes it possible to run PCC without the Windows user being
logged in. In this manner, PCC starts as soon as the PC is turned on or
restarted without a user having logged in.
The user name and password must still be entered in this case, however,
because as a system service, PCC requires a valid user context to be able to
access various user settings (for example the default archive directory).
The user who makes the settings for the system service requires administrator
rights. The user in whose context the system service is running can have
restricted user rights.

H

If PCC still cannot be started as a service even with administrator
rights, the reason may be lack of authorization for starting system
services.
Please contact the PC administrator.

Remove
service

The currently running system service is terminated.
At the same time PCC is removed as a system service, so that it will not run the
next time the PC is turned on or restarted.

Exit service

The currently running system service is terminated.
The next time the PC is turned on or restarted, PCC will be started again as a
system service.
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8.5

Tools

8.5.1 Enable Program Options
You can use this function to enable additional software options, or to license a
software that was installed as a demo version.
h Tools ➔ Enable program options

h Enter the license number and click “Registration”

A

After successful registration, the program must be closed and then
restarted, so that the newly enabled options can be activated.
No restart of Windows and no deinstallation is required!

8.5.2 Forgotten the License Number?
Registered
license
numbers

h Click Info ➔ Registered license numbers

Your license numbers for the installed software components will now appear.
Various software modules can be enabled, depending on the license number.
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8.5.3 Compressing the Device List
This removes unused areas that have developed in the database (device list) –
for instance, after deleting devices. If large gaps are present, compressing the
device list will reduce the time taken to load and save it.

8.5.4 Resetting the Device List
All the devices in the connection list will be deleted. None of the devices can be
active (reading out/retrieving data, Teleservice), not even for a different
program (Setup or PCS).

8.5.5 Importing the Device List
Opens a previously saved device list for importing. After the list is selected in
the following dialog, all or some devices can be imported from the list.

8.5.6 Save Device List
The current device list can be saved if no other device is active (data read-out/
retrieval, Teleservice). It is not possible to stop actions that are running.
v See “Cancel current transmissions” on page 72.

8.5.7 Reset all Error/Event Lists
Local error/event lists of all device entries are reset.
This does not affect the Audit Trail list.
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8.5.8 Synchronizing the Device Time
This function is only available for devices that support synchronization (e.g. the
paperless recorder LOGOSCREEN es/cf).
Synchronization is only possible if the time difference between the PC and the
device is not greater than 30 seconds.

System requirements means that synchronization is only effective for
differences >1 second. The residual error is <±1 second. After long periods of
connected operation (e.g. when using the Ethernet interface) the deviation can
rise to 2 seconds.

8.5.9 Changing the Device Password
This function is only available for devices that have user/password
management (e.g. the paperless recorder LOGOSCREEN es/cf).
This function provides the option for altering the password at the device itself or
via the interface – because of the remote location of the device or as a
convenient method that does not require detailed knowledge of operation.

H
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The function is useful if the device is operated at a remote location,
via Ethernet or a modem, or the user does not otherwise have
adequate knowledge of the system.
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8.5.10 Searching for a Device
This function

is used to search for connected devices on the interfaces

that have been set up.

H

By pressing the Shift or Ctrl key and the left mouse button you can
search through several interfaces for connected devices using one or
several baud rates. Depending on the setting, the search procedure
may take some time.

The search covers the
addresses 1 to 255 for
the COM1 and COM2
ports.

A

When using the connection via the setup interface, no search should
be made through an address area, since the search could find a
device and make an entry for every address, even though there is
only one device connection. Some devices ignore the device address
on the setup interface.
Depending on the communication interface that is used, the
appropriate valid dialog will be brought up on the screen. The
example shows the dialog for using the serial interface.

A device that has been found will be added to the list if:
- the connection settings have not yet been used
(e.g. for another device address or another baud rate) or
- the device identifier cannot be matched to any of the existing entries in the
list.
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8.5.11 Preparing the Device Modem
Recommended
modems

HSM 33.6
Analog
industrial modem
for mounting on
DIN rails

HSM ECO TA
ISDN
industrial modem
for mounting on
DIN rails

TC35i
GSM modem

Part number: 00416612

Part number: 00416611

Part number: 00440255

Tixi HG
GSM modem
with alarm function
for mounting on
DIN rails

Part number: 00487003
If other modems are used for the device, it may be necessary to alter the
initialization string. However, it is not possible to guarantee that the connection
will work. No support is available if other modems are used.
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This function is used to prepare (initialize) a modem so that it can be connected
as a device modem.
h Connect modem to PC via a standard modem cable.
Changeover between customized
and original init strings

Preparing the
device modem

Connection
These settings
must precisely match those
in the device.

The init (initialization) string for
the connected modem is
selected here.

The init string is
transferred to the
connected modem.

Only when
the customized “Initstring”
is active will
most of the
buttons on the
right-hand side
be made
available.

Alter init string
Create init string
Delete init string
Save alterations
adds to the list
of the customized init strings
the original
initstrings as well
The modem responses during
transmission appear here.

Alter sequence
of the init strings
(modem list)

h After entering the settings, click Transmit. When the the settings have been
sent, a result message for the initialization appears.
h Detach the modem from the PC and cable it up correctly to the device
interface.
If the modem responses includes texts such as “Error”, then the modem failed
to interpret one of the commands. You will have to correct the command or use
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a different init string.
After the software has been installed for the first time, the standard init strings
(one string per modem) will be copied and treated as “customized” strings. In
this way, any altered init strings will also be retained after a software update.
This function means that the original strings can be attached to the
“customized” ones, with the result that the modem list grows every time the
function is called up.
Interface
converter

If the device uses an RS422/485 interface, then the device modem must be
connected to the device via an interface converter (Spectra, type I-7520A) that
converts RS232 to RS422/485 levels.

H

If a different interface converter is used, it must be equipped with an
automatic data direction sensing function.

h Connect the device to the telephone network, via the Spectra interface
converter and the modem, as per wiring plan.
h Switch on the modem.
h Establish the new connection to the device via the modem.
v Chapter 8.2.1 "Device List"
Reset
modem

This resets the modem to the factory defaults, so that it can be used as a PC
modem again.
h Select a modem init string with the addition “Reset.”
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8.5.12 Renew Log-in / Alter Password
This is a standard dialog that helps to protect all components of the PC
software from unauthorized access. The software uses the log-in dialog for
mandatory identification via the password.
Cancellation or an incorrect password invalidates all the rights for the user. For
security reasons, even ending the program is only possible after entering the
correct password.
Exception

If automatic mode is switched off and no devices are active, then the program
can be ended.

Password
activation

For devices without an enhanced security level, the function Renew log-in /
Alter password is used to
- activate the user and password prompt at the program start and
- alter the current password.
This function only affects the operation of the software and not any device user
list that may be present.
Activation of the user and password prompt when the program starts
When the software is first newly installed, there will be no prompt for user name
and password. You will automatically be logged in as “Specialist”, with a blank
password.
Proceed as follows:
h Start the function “Renew log-in / alter password”.
h Show options.

Show options.

81

8 Menu Functions and Toolbar
h Activate option “After log-in – alter password” and click

.

h Enter the password – the “Old password” field remains empty.

When the entry has been concluded, click
to activate the new
password. From now on, the user name and the password will be requested
when the program starts.

H

Initially, no start password is assigned to the “Maintenance” user
either. When the program starts, log in with the “Maintenance” user
name and enter a password as described above.

Changing the password
Changing a password is very much like activating password administration.
The only difference is that in this case the “Old password” field must not remain
empty.
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8.5.13 Comment in Audit Trail
This creates an entry in the PC audit trail (PCAT) for the better understanding
of the activity that has been performed.

8.5.14 Start Audit Trail
This function starts the PC Audit Trail Manager software.

8.5.15 Set Audit Trail filter
If the filter is set, only the entries of the corresponding device are displayed in
the PC audit trail.
This function is only active if PC Audit Trail Manager software has been startted
before.
h Mark the device in the device list:

h Extras ➔ Set Audit Trail Filter
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8.6

View

Update

This updates the display on the screen.
If devices are added to the device list, e.g. through the Setup software, while
PCC is active, then this function adds the devices to the user interface of PCC.

Deleted devices will only be removed when they are inactive, i.e. no data is
being transferred.
With numbers

This inserts a unique ID number in front of every device name. This makes it
easier to find a device if names are duplicated. Once it has been set up, this
number is also used in the audit trail entries.

Minimize all/
Maximize all

All the settings shown in the dialog window are folded up (no detail view) or
unfolded (detail view).

Expand all/
Compress all

All device types, which are displayed in the navigation tree, are expanded (all
devices displayed) or compressed.
For this function the buttons
used also.
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(Expand all) and

(Compress all) can be
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Filters

The filter function can be use to filter out settings in the dialog window.

Show hidden

All hidden ements in the navigation tree are shown. This refers to empty device
types and device lists, device types, and devices marked "Hidden."
v Chapter 4.2 "Windows of the User Interface"

Hide

Device lists, device types, and devices can be marked "Hide." Then they will
not appear in the navigation tree. Then can be shown with function "Show
hidden."

8.7

Window

Cascade, tile
horizontally

Windows can be arranged cascading or tiled horizontally.

Arrange
icons

Arranges the icons in the lower part of the window.

Active devices

Here you can show or hide the window for active devices.
v Chapter 4.2 "Windows of the User Interface"

Output orders

The window for output orders can be displayed or hidden.
v Chapter 4.2 "Windows of the User Interface"

Window
selection

If several windows are open (for example device list, Teleservice), you can
switch between them here.
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8.8

Info

Info via PCC

Here you can obtain information on the version number of the program. Please
have this number available if you have technical problems or queries and
contact a service representative.
Click
button for additional information on any PC software
components that may be installed. Please have these numbers available as
well, if you have technical problems or queries and contact a service
representative.

Software
documentation

Opens the instructions for the PCA communication software (PCC) as a PDF
document.

Registered
license
numbers ...

Here you can obtain information on the license number of the program. Please
have this number available if you have technical problems or queries and
contact a service representative.

Program
folder

Your program data is saved here, on the hard disk.

The programs
reside here
The device list,etc.
is found here
Customized
data, suchas
modem strings is
found here
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Supported
devices

List of device versions supported by the currently installed version of the PCC
Communications Software.

xx means that these positions will not be
evaluated in the event of a version check
(e.g. 172.01.05 is just as valid
as 172.01.01

Automatic
devices

Shows all devices that have been configured for automatic mode (even if
automatic mode is not activated).
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9 FAQs
FAQ 1

Why can’t I see new devices that I created with the Setup software in the
PCC software (which had already been started)?

Answer

Click on the menu function View ➔ Update – the PCC software will then accept
the new devices.

FAQ 2

What is the difference between “Retrieve raw data” and “Read out raw
data”?

Answer

“Read out raw data ” does not affect the memory alarm of a device. On the
other hand, “Retrieve raw data” does affect the memory alarm. After the data
has been retrieved, any memory alarm that is present will be canceled.

FAQ 3

Why do some devices, e.g. LOGOSCREEN or IMAGO 500 (all the devices
with Type 1 memory) set the memory alarm during the read-out of raw
data?

Answer

In the navigation tree, activate the option “Only read data that has not been
retrieved yet” in the setting for “Times” in the “Advanced” tab.
Caution: When using manual read-out, you cannot make any further selection
of the quantity of data in this way.

FAQ 4

What is meant by Device Type 1 and Device Type 2?

Answer

Device Type 1 means devices that do not have a CompactFlash memory card
for retrieving the data from the device.
These are, for example, LOGOSCREEN, IMAGO 500 or F3000.
Device Type 2 means devices that use a CompactFlash memory card for
retrieving the data from the device.
These are, for example, LOGOSCREEN es and LOGOSCREEN cf.
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FAQ 5

How can I find the file with the measurement data, if the archive is only
set as a directory, and no file name has been set?

Answer

The name is assigned automatically and is derived from the device identifier
and a serial number.
If there are one or more files with different names already containing data from
the required devices, then the first file that is found will be used. A new file will
not be created.
Open the archive settings and click on PCA button (
). This automatically
opens the PCA3000 software with the correct archive (PCA3000 must already
be installed).
v „Edit archive” on page 63

FAQ 6

Why can’t I activate the buttons for reading out data from a device, even
though the device is not shown in the “Active devices” list?

Answer

The device is being used at the moment by a different software program (e.g.
the Setup or PCS software).

FAQ 7

Can the setup interface be used on all devices for reading out data?

Answer

No. Establishing a connection or reading out data via the setup interface only
works with devices that support that function on that interface.
v See also note on Page 33

FAQ 8

Why doesn't my PC modem (analog) create any connection to a device
modem (ISDN)?

Answer

ISDN modems use the X.75 protocol. This protocol is not supported by the
analog modem.
An ISDN PC modem can bring up an analog modem, but only together with a
CAPI port driver on the PC.
The following modem connections are possible:
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PC modem

Device modem

Analog

Analog

Analog

GSM

ISDN X.75

ISDN

ISDN V.110

GSM

ISDN with CAPI port driver

Analog

Analog and a/b adapter
on the ISDN connection

Analog
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